
Before returning this product to the store for any reason, please 
contact our �Parent Service Center at  

1-800-704-8697 or cs@learningcurve.com

Often, we can provide helpful tips and instructions to resolve your 
problem �quickly over the phone or by e-mail.
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Safety Instructions
	T his symbol is intended to warn the user of potential safety hazards.

	 	T his symbol is intended to alert the user to a potential risk of 			
	 	 electric shock and other electrical safety issues.

	WARNING:
•	To prevent electric shock or strangling by the cord, KEEP OUT OF 

CHILD’S REACH. Never place monitor or cord within 3 feet of child or 
attach to a crib or playpen.

•	Never place these units within a child’s reach.

•	This product is not a toy; do not allow children to play with it. 

•	The product is designed to assist in the monitoring of children, not as a 
prevention for injury to or loss of a child.

•	This product is not a substitute for proper adult supervision. All children 
should be supervised at all times by responsible adults.

WARNING
To reduce the risk of fire or electrical shock, do not open this product or 
expose the product to:

•	Water and Moisture: This product should not be used near water,  
for example, near a bathtub or sink, in a wet basement or near a 
swimming pool.

•	Heat: This product should be situated away from heat sources such as 
radiators, heat registers, stoves, or other appliances that produce heat.

IMPORTANT

•	The user should not attempt to service this product. Read all safety and 
operating instructions before operating this product.

•	Retain these instructions for future reference.

•	Observe all warnings.

•	Follow all operating instructions.

•	Do not tamper with the plug under any circumstances.

•	Power Source – This product should be connected only to the power 
supply provided.

•	Cleaning—Before cleaning, be sure to unplug. Clean only as 
recommended in these instructions.

•	Object and Liquid Entry—Care should be taken so that objects do not 
fall and liquids are not spilled into the enclosure through the openings.

•	Damage or Malfunction—Please contact our Parent Service Center at 
800-704-8697 or cs@learningcurve.com if:

a.	The power supply cord or plug has been damaged

b.	Objects have fallen or liquid has been spilled into it

c.	The product has been exposed to rain

d.	The product does not appear to operate normally or exhibits a 
marked change in its performance

e.	The product has been dropped or the enclosure damaged.

Wall Mounting—The Child Unit should be mounted to a wall only as 
recommended in these instructions.

WARNING
Do not mount the Child Unit in a location where the unit or the adapter cord 
is within the child’s reach. Never place monitor or cord within 3 feet of child 
or attach to a crib or playpen.

To prevent injury, this apparatus must be securely attached to the wall in 
accordance with the installation instructions.
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The First Years Home and Away Portable™ 

Digital Video Monitor

The First Years® Home and Away Portable™ 
Digital Video Monitor enables you to see and 
hear your infant from just about anywhere in your 
house. It is compact, lightweight, easy to set up, 
and easy to use.

The wall-mountable Child Unit features a video 
camera that can be tilted and swiveled to give 
you the view and angle you want. The Parent Unit 
is compact and lightweight, with a convenient 
belt-clip, so it’s easy to keep with you. Plus, the 
Parent Unit has talkback capability, so you can 
speak to your child from a different room, or a 
different part of the house. Automatic night-

vision technology means you can still see a low-light image of your child at night 
when the nursery is dark. Rechargeable batteries are supplied for the Parent 
Unit, which has an automatic 30-second display shut-off to save energy and 
extend battery life. 

For expanded capability, you can add up to three more cameras to the system, 
so you’ll be able to keep an eye on several locations in your home at the same 
time.

Plug the Parent Unit into your home computer using the USB cable provided, 
and open a whole new world of features and opportunities. With the software 
provided, you’ll be able to view your baby from the computer, and even take 
pictures and video! You can also download Skype® or use an existing account 
to access your Monitor from anywhere in the world. By using Skype on any 
computer connected to the internet you will be able to see, hear, and talk to your 
baby just as you would with any Skype video chat. This Monitor was designed to 
truly maximize your ability to stay connected to your baby from home and away.
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Parent Unit

Volume control button

Power button

Talk button

Battery indicator 

Sound level indicator 

Connection indicator

Camera scan button

OK/Zoom button

Directional pad

Menu button

Display screen

Speaker/microphone

Power jack

Headphone jack

PC connector (USB port)

Battery cover (not pictured)

Belt clip/stand (not pictured)
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Child Unit 

Antenna

Microphone

Power button

Nightlight button

Talkback volume switch (not pictured)

Connection indicator

Camera 

Adjustable-angle camera base

Wall mount slots (not pictured)

Cord channel (not pictured)

Nightlight

Battery cover (not pictured)

Power jack (not pictured)

Also Included

AC adapters (2) (not pictured)

USB cable (not pictured)

Software disk (not pictured)

 Parts Diagram
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1.	 Position the Child unit 4 to 6 feet from 
your child’s crib or the area you wish to 
view. NEVER position the unit within a 
child’s reach.

2.	Insert the connector on the AC adapter 
into the jack on the back of the unit, 
then plug the adapter into an electrical 
outlet.

Note: Use attached hook & loop strip to gather and secure any excess cord.

3. Lift the antenna to its full upright 
position.

4. Rotate the camera out from the base 
and swivel it to the angle you think will 
give you your best view.

5. Use the Talkback Volume Switch on the 
back of the Child Unit to choose your 
preferred setting:

Low for quietest, or High for loudest. 

Additional cameras
You can position up to three additional cameras in your home to monitor  
different locations. To find out where you can purchase additional cameras for  
your Monitor, please contact our Parent Service Center at 800-704-8697 or  
purchase directly at thefirstyears.com.

For wall mounting (recommended)
1. 	Press the adapter cord into the grooved channel 

on the back of the unit, making certain to slide it 
under the two holding clips.

2. 	Securely fasten two #8 “pan” head screws to the 
wall, one above the other, exactly 1 inch apart, 
leaving the screw heads protruding by at least ¼ inch.  
For best results use a 3/4-inch long screw; mount in  
a solid wood panel, or use screw anchors.

3. 	Fit the round openings on the wall mount slots over  
the screw heads, then slide the unit down until it is  
seated firmly.

4. 	To test that unit is securely mounted, press on its top  
and side edges.

To Set Up—Child UnitQuick Start Instructions

You’ll find detailed instructions on the pages that follow. Please read 
the Safety Instructions on pages 2–3.

Set up the Parent Unit
For portable use Install the rechargeable battery pack provided. Battery 
compartment is on back of unit. Loosen screw to release it, and slide cover off. 
Insert plug on battery pack into connector inside compartment, then fit battery 
into place. Replace cover and secure it by tightening the screw.  Connect one of 
the AC adapters to power jack and plug cord into wall outlet. 

IMPORTANT
CHARGE BATTERY FOR 8 HOURS BEFORE INITIAL USE.

For plug-in use: Connect one of the AC adapters to power jack and plug cord into 
wall outlet.

Set up the Child Unit

• Place unit 4 to 6 feet from child’s crib or play area. 

• Connect remaining AC adapter to unit and plug into wall outlet.

To use
1. Hold down power button on Child Unit until connection indicator lights up 

and blinks to turn it on .

2. Move antenna to full upright position.

3. Lift camera to upright position.

4. Hold down power button on Parent Unit until screen lights up to turn it on.

5. Connection indicators on both units should glow blue indicating they are 
connected.

6. Adjust camera position to ensure desired view is displayed.

7. Press + or – to adjust the volume of the Parent Unit.

Note:  Display on the Parent Unit will go blank after 30 seconds if unit is 
powered by batteries.  This is a normal power-saving feature.  Pressing any 
button on Parent Unit will reactivate the display.  This feature can be turned off 
through menu in Parent unit.

Before returning this product to the store for any reason, please contact our 
Parent Service Center at 800-704-8697 or cs@learningcurve.com.

Often, we can provide helpful tips and instructions to resolve your problem 
quickly over the phone or by email.

talkback volume switch on Child Unit

cord in grooved channel

slots in unit slide 
over screws
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For temporary/battery-powered operation
Loosen the screw to release the battery  
compartment cover, then slide and lift it off. 
Insert three AA batteries, positioning them so 
the + and – symbols on the batteries are aligned 
with the corresponding symbols in the battery 
compartment. Replace the cover and secure it  
by tightening the screw.

IMPORTANT
Use of batteries to power the Child Unit is intended  
only for temporary use during a power outage  
or when a plug-in electrical outlet is unavailable.  
Check the low battery indicator often, and  
replace batteries as necessary.

WARNING
•	KEEP OUT OF CHILD’S REACH.

•	Do not place Child Unit in crib or attach to crib or playpen.

•	Never place monitor or cord within 3 feet of child or attach 
to a crib or playpen.

•	Do not mount the Child Unit in a location where the unit or 
the adapter cord is within the child’s reach. 

To Set Up – Parent Unit

To install and charge batteries
1. 	Loosen the screw to release the 

battery compartment cover. Then, 
slide the cover off. 

2. 	Insert the plug on the battery pack 
into the connector inside the battery 
compartment.

3. 	Fit the battery pack into the 
compartment.

4. 	Place the cover back onto the battery compartment and secure it by tightening 	
	the screw.

5. Charge the battery: Insert the connector on the AC adapter into the  
power jack on the side of the unit, and plug into an electrical outlet. The 
battery needs to be charged for 8 hours before the first portable use. 

IMPORTANT:
If the Parent Unit is on, the power indicator will glow purple 
while the battery is charging. Once the battery is fully 
charged, it will glow blue. 

For plug-in use/recharging
Reconnect the Parent Unit to the AC adapter as for initial battery charging, and 
plug the adapter into an electrical outlet. If desired, open the stand to support 
unit in upright position for viewing and operating.

•   You may use the Monitor while charging; however, it will take longer to charge 
when in use. 

•   For best results, recharge daily. Keep plugged in overnight or for several hours 
a day.

IMPORTANT:
•  Use only the AC adapters supplied with this product; use of 

any other adapter(s) could damage Monitor and would void 
warranty.

•  AC adapters should be regularly examined for signs of 
damage to the cord, plug, enclosure or other parts; in the 
event of such damage, it must not be used .

•  To obtain replacement AC adapter: please call our Parent 
Service Center at 800-704-8697

WARNING:
•	Batteries may explode or leak if not used correctly. Follow all 

instructions for proper installation, use and storage.

install batteries in compartment

hold belt clip open to install battery pack

Optional Stand For Child Unit

An optional stand has been included with the Home and Away™ Digital Video 
Monitor. This stand allows you to better view your baby from tough angles.

To Install:
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1. 	Hold down the power button on the Child Unit until connection indicator 
lights up. The connection indicator will blink to indicate it is searching for the 
Parent Unit.

2. 	Hold down the power button on the Parent Unit until the screen lights up. 
Connection indicator will blink, and start-up graphics will be displayed on 
the screen. 

3. 	Once the two units are connected, live video will be displayed, you will hear 
sounds from your child’s room (or wherever you have placed the Child Unit), 
and connection indicators, on both units will glow blue.

4. 	On the Parent Unit, press + and/or – on the volume button to adjust loudness 	
	to the desired level.

5. 	Always keep the Parent Unit with you, or nearby.

To Use

To turn the Parent Unit off
Hold down the power button until the power light goes out.   
This takes a few seconds.

To turn the Child Unit off
Hold down the power button until the power light goes out.  
This takes a few seconds.

Tip: A loud screeching sound indicates the Parent Unit is too close to the Child 
Unit. To avoid this noisy feedback (which is common with audio devices), lower 
the volume on the Parent Unit (or turn it off) when entering your child’s room (or 
any room where you have set up the Child Unit or an add-on camera).

Important
The power indicators on the Parent Unit will glow red when 
battery power is low. Batteries in the Parent Unit should be 
recharged as soon as possible. 

The power indicators on the Child Unit will glow red when 
battery power is low.  Batteries in the Child Unit should be 
replaced. (See “Recharging/Replacing Batteries.” On p. 24)

Display Sleep Mode (Display Disappears after 30 seconds)
•  	When the Parent Unit is being operated on battery power, the display will go 

into sleep mode automatically. This means the screen will go blank after 30 
seconds. It will always turn back on whenever sounds picked up by Child Unit 
indicate the baby is active or crying.

•  	To turn display back on at any time: Press any button.

•  	To return the display to sleep mode more quickly than 30 seconds (and save 
even more battery power): Press the power button . The screen will go blank. 

•   Sound will always be transmitting even when the display is blank, unless unit is 	
	turned off.

Note: The unit will not go into Display Sleep Mode when it is plugged into the AC 
adapter. The Display Sleep Mode can be turned off during portable (battery) use 
via the Menu.

Sound Activation
•   The display will remain blank when sound level in the camera location is low. 

•   Once sound level from the Child Unit indicates child may be crying, or making 	
	loud noises, the image will be displayed. 

Child Unit

Parent Unit
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Range
The distance you can separate the units and still maintain a connection will 
vary based on the layout and construction of your home. To test the Monitor’s 
workable range, walk though your house and yard to check for the volume of 
sounds being transmitted and the clarity of images being displayed.

Night Vision
The Home and Away Portable Digital Video Monitor is equipped with night 
vision technology that enables the transmission of video images even when  
your child’s room is dark. In low light situations, the display will appear as a 
black-and-white image.

Talkback Feature:  
Two Way Communication 
Press and hold the Talkback button on 
the Parent Unit while speaking. Your child 
will be able to hear your voice.

Use the Talkback Volume Switch on the 
back of the Child Unit to choose your 
preferred setting:

Low for quietest, or High for loudest.

Note: 
•   While the Talk button is depressed, you will not hear any sounds being 
	 transmitted by the Child Unit.

•   When using more than one camera, the talk feature will link to the camera in 
the location you are currently viewing.

Belt Clip/Stand
Press on the top of the belt clip to open; 
slide it onto waistband or belt and release.

Or, lift the tip of the stand away from the 
unit and set the unit on any flat surface.

Tip: Belt clip/stand can be removed 
from the Parent Unit to make it even more 
compact. To remove, unscrew the  
retention screw on the top of the belt clip.  
Once unscrewed, lift the assembly off.

Headphone Capability
Headphones are not supplied with the 
Monitor. However, you can use any 
headphone with a standard 3.5mm plug; 
simply insert plug in headphone jack. 
Sounds will be transmitted through the 
headphone only. No sounds will come out 
of the speaker.

Parent Unit Finder Feature
If you should misplace the Parent Unit, turn off the Child Unit, and wait 5 
seconds. The Parent Unit will beep, and continue beeping until it is found and 
turned off (or the batteries are exhausted). Turn Child Unit on before turning the 
Parent Unit back on.

Note: This feature will not work if Parent Unit is turned off or has lost power due 
to a dead battery. 

talkback volume switch on Child Unit

belt clip/stand

headphone jack on Parent Unit
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Video Display 
The display screen will show live images being 
transmitted by the Child Unit.

Clock:  

The current time of day is shown in the upper right 
corner of the display.  Time is set using the Menu 
(see page 18 for full instructions).

Camera Scan Button
This button allows you to scan through multiple 
cameras if you have added cameras to your video 
monitoring system.

OK/Zoom Button
Zoom Function 
Press the button once to zoom in on the image.  
Press the button again to revert to original size.

OK Function 
The button is also used to select options when Parent Unit is in Menu mode.

Directional Pad 

Pan Function
If you have already zoomed in on the display, use the directional pad to move 
around to obtain the desired view.

Note If directional pad is pressed and you have not pressed , image will 
automatically zoom and move in direction pressed.

Menu Navigation
The directional pad is also used to navigate menu options when Parent Unit is in 
Menu mode.

Menu Button
The Menu Button allows you to change current settings for various preferences 
(see section that follows for complete details).

Parent Unit Indicators and Controls

Power/Battery Level Indicator
•Blue glow indicates full power.

•Red glow indicates battery power is low. Recharge as soon as possible.

•Purple glow indicates battery is charging.

•No light indicates no power. Unit will not work until turned on or recharged.

Connection Indicator
•Blue glow when connected to Child Unit

•Blinking blue light means that connection has not been made or is lost.

Sound Level Lights
No lights indicates lowest volume.

All lights indicates highest volume.

Volume Control [ + , - ]
Press either side of the volume control button to make sounds louder (+) or softer (-).

Talkback Button

Press the button while speaking. Your child will be able to hear your voice.

Note 
•   While using the Talkback button, you will not hear any sounds being transmitted 	
	 by the Child Unit.

•   When using more than one camera, the talkback feature will link to the camera in 	
	the location you are currently viewing.

OK

OK

sample video display
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Menu Choices—Your Preferences for Selected Features
You have the option of setting menu preferences for the Monitor features listed 
below. To review or change any preferences, press the Menu button. Use the 
directional pad to scroll through the available menu choices. Use the OK button 
to make and accept changes.

Nightlight
To turn the nightlight (on the Child Unit) ON or OFF from the parent unit:

1. Press the Menu button.

2. Press the OK button to change the setting for the Nightlight.

3. Press Menu button to return to the display mode.

Note: When Child Unit is being powered by batteries, Nightlight will turn off 
automatically after 60 seconds. You can use this Menu feature to turn it back on 
at any time.

Brightness
To set the brightness of the display on the Parent Unit:

1. 	Press the Menu button.

2. 	Use the top or bottom of the directional pad to scroll through the list of 	
preferences until “Brightness” is highlighted. 

3. 	Press the OK button.

4. 		A Brightness Selector Scale will appear, displaying five possible settings. The 
current setting will be shown Use the directional pad to move the box to the 
right to make the display brighter, or to the left to make the display 
darker. 

5. 	Press the OK button to confirm your selection.

Reminder: If you do not press the OK button, no change will be made. 

6. 	Press the Menu button to return to the display mode.

Clock
To select a 24-hour clock or a 12-hour clock, and to set the current time:

1. Press the Menu button.

2. Use the top or bottom of the directional pad to scroll through the list of 
preferences until “Clock” is highlighted. 

3. Press the OK button.

4. A “12hr/24hr” Preference screen will appear. The current setting will be with a 
highlighted. Use the sides of the directional pad to move the box to the right to 

choose a 24-hour clock , or to the left        to choose a 12-hour clock 
and press OK button to accept. 

5. A digital clock display will now appear showing [t12:00u] the current time 
setting. 

6. To set the time:

a. Select the hours in the display using the top or bottom of the directional pad.

b. Press the right side of the directional pad to go to the first minute digit.

c. Use the top or bottom sides of the directional pad to select this digit.  

d. Press the right side of the directional pad to go to the second minute digit.

e. Use the top or bottom sides of the directional pad to select this digit.  

f.  Once you are satisfied this is the correct time, press the OK button to accept it. 

Reminder: If you do not press the OK button, no change will be made. 

7. Press the Menu button to return to the display mode.

Add/Remove Camera 
To add or remove cameras for your video monitoring system:

1. 	Press the Menu button.

2. 	Use the top or bottom of the directional pad to scroll through the list of 	
preferences until “Add/Remove Camera” is highlighted. 

3. 	Press the OK button.

4. 		Select whether you want to Add or Remove a camera on next screen using the 	
	sides of the directional pad to highlight your choice.

5. 		Press the OK button.

6. 		Follow the screen prompts to complete this operation.

24HR
12HR
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Language
You can choose to view displays in English, Spanish or French. To change your 
language selection: 

1. Press the Menu button.

2. Use the top or bottom of the directional pad to scroll through the list of 
preferences until “Language” is highlighted. 

3. Press the OK button.

4. A Language List will appear. The current setting will be highlighted. Use the 
directional pad to highlight the language of your choice. 

5. Press the OK button to confirm your selection.

Reminder: If you do not press the OK button, no change will be made. 

6. Press the Menu button to return to the display mode.

Display Sleep Mode
When the Parent Unit is in portable use (not plugged into an electrical outlet via 
the AC adapter), Display Sleep Mode helps conserve battery power by turning 
the display off automatically after 30 seconds. The display will come back on 
any time sounds being transmitted indicate the baby is crying or making loud 
noises; you can also turn the display back on by hitting any button. You can 
choose to turn the Display Sleep Mode on or off. To do so:

1. Press the Menu button.

2. Use the top or bottom of the directional pad to scroll through the list of 
preferences until “Display Sleep Mode” is highlighted. 

3. Press the OK button.

4. A “Display Sleep Mode Status” screen will appear. The current setting will be 
highlighted. Use the directional pad to highlight the setting that you want. 

5. Press the OK button to confirm your selection.

Reminder: If you do not press the OK button, no change will be made. 

6. Press the Menu button to return to the display mode.

Camera Scan Mode
When multiple cameras are connected to your video monitoring system, the 
camera scan mode can be used.  Scan mode will display an image from each 
camera for a short period of time and then advance to the next camera.  For 
2 cameras the display time is 10 seconds each.  For more than 2 cameras the 
display time is shortened to 6 seconds each.  You have the option to turn on this 
scan mode as follows:

1. 	Press the Menu button.

2. 	Use the top or bottom of the directional pad to scroll through the list of 
	 preferences until “Camera Scan” is highlighted.

3. 	Press the OK button. 

4. 	A “Camera Scan” screen will appear. The current setting will be highlighted. 		
	 Use the directional pad to highlight the setting that you want. 

5. 	Press the OK button to confirm your selection.

Reminder: If you do not press the OK button, no change will be made. 

6.  Press the Menu button to return to the display mode.

Support
The Support menu selection provides you with information on how to contact 
our customer service representatives, who will gladly assist you with any 
problems that you may have with your video baby monitor system.  To access 
the Support screen:

1. Press the Menu button.

2. Use the top or bottom of the directional pad to scroll through the list of 
preferences until “Support” is highlighted. 

3. Press the OK button to display the Support screen.

4. Press the Menu button to return to the display mode. 

Default
Menu choices are preset to the factory defaults listed below. Once you have 
made changes to menu selections, you have the option of returning all choices 
to the Factory Presets. To do so:

1. Press the Menu button.

2. Use the top or bottom of the directional pad to scroll through the list of 
preferences until “Default” is highlighted. 

3. Press the OK button.
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4. The “Default” screen will appear. Use the sides of the directional pad to 
highlight either “NO” or “YES.” If you choose “YES,” all Menu options will 
revert to the Factory Presets listed below. If you choose “NO,” all Menu 
options will remain as you have most recently set them.

5. Press the OK button to confirm your selection.

6. If you chose “YES” a second selection screen will appear.  If you still want 
to change to the Default settings, highlight “YES” and press OK button to 
confirm your selection.

Reminder: If you do not press the OK button, no change will be made. 

7. Display screen will now go blank and unit will restart with Default settings.

Factory presets are as follows:
Brightness: 0

Clock: 12 hour

Language:  English

Display Sleep Mode:  ON

Camera Scan: OFF

* Multiple cameras are not changed when default is selected.

Power button
•  Hold down to turn unit on or off.

•  Blue glow indicates full power.

•   Red glow indicates battery power is low. Replace batteries as soon as possible.

•   No light indicates no power. Unit will not work until turned on, connected to AC 
adapter or powered by good batteries.

Nightlight button
•   Press to turn the nightlight on or off.

Note: When Child Unit is being powered by batteries, nightlight will turn off 
automatically after 60 seconds. 

Connection Indicator
•   Glows blue when connected to Parent Unit

•   Blinks blue when not connected

Talkback Volume Switch
•   Allows you to choose your preferred setting for talkback volume to the Child 

Unit. Three settings are provided: Low, Medium, and High. 

Child Unit Indicators and Controls
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Recharging/Replacing Batteries

Parent Unit:
If Power Indicator on the Parent Unit glows red when unit is turned on, batteries 
are low. If indicator does not light at all, batteries may be dead. Recharge 
batteries by connecting AC adapter cord to power jack and plugging it into wall 
outlet. When charging the unit for the first time, it should be kept plugged in 
for at least 8 hours; when recharging, you should keep it plugged in until power 
indicator glows blue indicating that batteries are at full power.  

Unit can be used while being recharged; however, it will take longer for batteries 
to charge fully.

To ensure that Parent Unit is always available when you need it, recharge daily. 
For best results, connect adapter and keep unit plugged in overnight, or for 
several hours each day.

Important: 
Each rechargeable battery pack is designed to last through 
many recharge cycles. However, like all batteries, it will 
wear out over time. If you notice that the battery is retaining 
its power for only a short time and requires charging 
frequently, the battery pack should be replaced.

To obtain a replacement battery pack: Please call our Parent 
Service Center at 800-704-8697. Use ONLY the battery pack 
supplied.

Child Unit

Important: 
Remember that the Child Unit can be operated on batteries for 
only a limited time; once the batteries run down, the unit will 
not work. Battery use is intended only during power outages 
or in temporary situations where electricity is not available. 
If you are operating the Child Unit on batteries, check the 
power light frequently, and replace batteries once power 
button glows red. 

Tip: Use alkaline batteries for longer battery life.

WARNING
Keep batteries away from children. Parents are urged to exercise 
care in the storage, use and disposal of all batteries. Do not dispose 
of batteries in a fire. They may explode.
To avoid battery leakage:

•	 Do not use rechargeable batteries; 
•	 Batteries must be removed and inserted under adult supervision; 
•	 Non-rechargeable batteries are not to be recharged; 
•	 Batteries are to be inserted with the correct polarity; 
•	 Exhausted batteries are to be removed from the unit and disposed properly; 
•	 Supply terminals are not to be short-circuited; 
•	 Different types of batteries (e.g. alkaline, standard carbon-zinc or 

rechargeable) or new and used batteries are not to be mixed; 
•	 Do not dispose of batteries in fire, may explode or leak. 
•   Never use a screwdriver or any other tool to pry batteries from the 

compartment, as the supply terminals could be short-circuited.
•   Do not leave batteries in the Monitor for long periods of non-use.

Failure to follow these instructions may cause batteries to make popping sounds 
and leak battery acid, which could result in personal injury, as well as damage to 
the Monitor. If battery leakage occurs, avoid all contact with battery acid, being 
especially careful to keep it away from eyes and mouth. Should contact occur, 
wash any affected skin and clothing thoroughly.

IMPORTANT:
•  If batteries are installed in Child Unit, check for signs of 

battery leakage at least every six months.

•  Always dispose of used batteries in an environmentally 
friendly manner.

Alkaline batteries  and Nickel Metal Hydride batteries (Ni-Li or Ni-Hydride), 
are classified as non-hazardous waste (except in California) and can be either 
disposed of in the trash or e recycled at a local recycling center. In order to 
find a center near you, go to www.ehso.com; using the search function, type 
in “Batteries” and select the Battery Disposal Guide for Households. This will 
provide a link to nearby centers based on zip code.
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Pairing of Parent and Child Units

The Parent Unit and Child Unit are digitally paired at the factory. This means they 
are digitally encrypted with the same electronic code so that they can securely 
communicate with each other and not be confused by the signals sent out by 
other electronic devices, such as cell phones or other monitors.

It is unlikely, but possible, that strong electronic interference, such as a power 
surge, could erase this pairing. Should this occur, you can reset the pairing as 
described below.

1. Press the Menu button.

2. Use the up or down buttons on the directional pad to scroll through the 
list of preferences until “Add/Remove Camera” is highlighted. 

3. Press the OK button.

4. Use the sides of the directional pad to highlight ADD

5.  Press the OK button

6.  Follow the screen prompts to complete this operation.  Please note that you 		
	will be adding camera “1”.

Note: The above assumes that you only have one Child unit.  If you have multiple 
cameras connected to your video monitor system, you can use this same method 
to re-connect cameras that have become unlinked.

Need Further Assistance?

If you follow these instructions, and your Monitor still does not function 
properly, please contact our Parent Service Center at 800-704-8697.

Care

To Clean

Do not immerse the Parent and Child Units in water. Do not use cleaning spray 
or liquid cleaners.

1. Disconnect units from adapters (if connected) and unplug adapters from 
electrical outlets if they are plugged in.

2. Wipe units and adapters with a damp cloth. 

3. Make sure all components are dry before reconnecting them.

Storage
When you are not going to use your Home and Away Portable Digital Video 
Monitor for some time, remove the batteries from the Child Unit and the battery 
pack from the Parent Unit. Store in a clean, dry place.
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Installing Software
Insert the provided CD into the CD drive  
on your computer and install the  
software following on-screen directions.

Note: Software will search the Internet  
every time it opens to look for updates.   
You can determine if you want the 
software to update.

Setup & Usage
1. Turn on Child Unit, then Parent Unit. Verify connection by checking image on 

screen of Parent Unit.   

2. Connect the Parent Unit to your computer using the supplied cord.  

Important: 

Note: It is best to power your Parent unit with the supplied AC adapter while 
using it with your home computer.

3. Once connected the screen on the Parent Unit will go blank and all video and 
audio will come from your computer.  

4. Open the on-screen display by double clicking on the Icon  located on 
your desktop.

5. You are now ready to use your computer as your video monitor.  Please review 
the following descriptions of the On Screen Display to understand all of the 
features of this software.

On Screen Display 
The indicators, controls, and video display you’ll see on your computer screen 
will be quite similar to those on the Parent Unit itself, with two significant 
additions. Home and Away Portable Digital Video Monitor software allows you 
to capture and save both still images and record video.

Instant Help
Use your mouse to hover over any button; an explanation of that button’s 
function will be displayed in a pop-up window.

1. Install Baby Viewer software on your computer by inserting the supplied disk 
and following on-screen prompts.

2. With your Video Monitor system on, connect the Parent unit to your home 
computer via the supplied USB cable as follows:

Insert the larger end of the supplied USB cable in the USB port 
on your computer.

Insert other end of the cable in the USB jack on Parent Unit. 

Note:  It is best to power your Parent unit with the supplied 
AC adapter while using it with your home computer.

3. Screen on Parent Unit will go blank; video and sounds will now be transmitted 
by computer.

4. While connected you can take pictures and video, as well as connect with the 
Monitor via the internet from anywhere via Skype.  See pages 36–37 for full 
instructions.

Note: You can only use the Video Monitor with one computer program at a time 
(i.e. Baby Viewer or Skype).

Operating the Monitor from your computer is quite similar to operating the 
Parent Unit, itself. For complete instructions on using Baby Viewer software, 
please see page 30.

Baby Viewer Software
This software will allow you to use your personal computer as a parent unit, while 
also giving you the ability to take still pictures and record video of your child.  

About the Software
Software is compatible with current Windows PC operating systems.

Note: If this software is lost, it can be downloaded from our Website:
www.thefirstyears.com/homeandaway

Installation Requirements

PC: 
Windows® XP (SP2 or higher), Vista® or Windows® 7 (32-bit or 64-bit)

•   1 GHz (1.6 GHz recommended) 
•   512 MB RAM or more 
•   200 MB hard drive space 
•   CD-ROM drive 
•   OS-compatible sound card and speakers 
•   1.1 USB port (2.0 recommended) 

sample display on computer screen
USB jack on Parent Unit

Using Your Computer as Parent Unit
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Still Image Capture 
Click on the camera icon      . You will hear a shutter sound.

The image file will automatically be saved to the default location. File location 
will be displayed in the lower left corner of the window. You can click on this file 
location to see the picture you took. 

The file location can be changed in Preferences in File menu.

Video Capture  
1. Click on the Video icon  to start recording. You will hear a sound at the 

start of the recording.

2. Video will be recorded until you click on the Video icon again.

A flashing on-screen display        in red tells you that the image on your display is 
being recorded.

Note: Maximum recording time is 20 minutes. Recording will stop automatically, 
even if you have not clicked the Video button again. 

The video file will automatically be saved to the default location. File location 
will be displayed in the lower left corner of the window. You can click on  this file 
location to watch the video you just made. 

This location can be changed in Preferences in File menu.

Mini Mode
Use the Mini Mode display screen to maximize space on your desktop:  This 
mini display screen will remain on top of any other active application windows 
on your computer screen, so you can watch your child while working on your 
computer.

Click on the to create the mini display screen.  This screen can be moved to 
any location on your computer desktop.

Note: When the mini display screen is being used, only the video image being 
captured by the Child Unit is displayed. You must restore the display to full size 
for access to the control buttons. 

To restore the Control Panel display to full size: Click on the .

Talkback Feature
1. Click on the Talkback Button,          and hold your mouse button depressed 

while speaking. 

2. Your child will be able to hear your voice. An on-screen display        in red tells 
you that you are transmitting your voice.

•   While the Talkback button is depressed, you will not hear any sounds being 
transmitted by the Child Unit.

•   When using more than one camera, the talk feature will link to the camera in 
the location you are currently viewing.

Note: For this feature to work, your computer must be equipped with a 
microphone.

Zoom Feature
•   Click on the Zoom Button to zoom in and out.

•   Click once to zoom the display image. 

•   Press again to revert to original size. 

Pan Feature
Use directional pad to view different areas of the image once it is zoomed.  

Camera Identification/Selection  
Add/Remove Cameras 
(If you have linked additional cameras to your Monitor)
Select File from the menu and then choose “Add/Remove Camera.” Follow on 
screen instructions to add or remove cameras. 

The system identifies cameras by number 1, 2, 3, 4 assigned when they were 
added. If you have not added any cameras to your system, the camera icon will 
be greyed out and the Camera Selection button will not respond when you try to 
click on it.

Click the camera button           to switch the display to the next camera in the 
numerical sequence.Click through the cameras in sequence until you reach the 
one you want to view. The number of the camera currently transmitting will be 
highlighted on the Control Panel.

If you have multiple cameras installed and active, the software can display each 
of these cameras in a scan mode, like the Parent unit. This scanning feature can 
be turned on by going into the Video tab in the Preferences in the File menu.
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Keyboard Shortcuts

S = Still photo

Z = Zoom

C = Camera Select

V = Video 

M = Mini Display Screen - toggle

Spacebar = Talkback (hold while talking)

 = Pan image up

= Pan image down

= Pan image left

= Pan image right

Note: Keyboard shortcuts can be used in mini mode. 

File Menu Options:

Change Language — allows you to chose between English (default), Spanish 
and French.  Once selection is made the language used in the software will 
change.

Preferences — opens the Preferences Screen with the following topics:

Still Image – allows you to change the location that your still images are 
stored and the naming convention for these images.

Video — allows you to change the location that your video recordings are 
stored and the naming convention for these images.

Camera — allows you to turn on or disable the display scan mode for multiple 
cameras, as well as open a Wizard to allow you to add & remove cameras from 
your video monitor system.
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10.	 Again, select “Options” from the Tools menu.

11.		 From the list of Options, choose “Video Settings.” 

12.	 In the Webcam Dialog Box, select “USB Video Device.” This designates the 	
	 Child Unit of your Home and Away Portable Digital Video Monitor as your 	
	 new video camera.

13.	 Click the “Save” button.

14.	 Once again, select “Options” from the Tools menu.

15.	 Choose the “Calls” option, then click on “Call setting.”

16.	 Select “people in my Contact list only.” This setting protects your privacy.  

17.		 Click in the “Answer incoming calls automatically” check box. This setting     	
	 enables Skype to receive transmissions from your Home and Away 	
	 Portable Digital Video Monitor automatically.

18.	 Click on the “Save” button.

These settings will enable you to receive audio and video transmissions from 
your Home and Away Portable Digital Video Monitor, and to speak to your 
child, remotely, just as you would if using your home computer with its USB 
connection to the Parent Unit.

Note: These instructions were developed for Skype Version 4.0.32.227.  If these 
instructions do not match your Skype interface, please follow latest Skype setup 
instructions or check Skype.com.  

Using your Home and Away Portable™ 
Digital Video Monitor with Skype®

Your Home and Away Portable Digital Video Monitor comes ready to use with 
Skype.  Skype is a free program that allows you to make video and voice calls 
over the internet to anywhere in the world.  With this feature you can check into 
your nursery camera and even talk to your baby from any computer with internet 
access.  Check out skype.com for more information and enjoy this wicked cool 
way to keep your family even closer!

For maintaining privacy for your Home and Away Portable Digital Video Monitor, 
we recommend that you setup a new Skype account for use with this system.  
Having this new Skype account will allow you to only include people that you 
trust to view your child as contacts.  To setup your Skype account, go to skype.
com and follow instructions.

1.  With your Video Monitor system on, connect the Parent unit to your home 
computer via the supplied USB cable.  

Note: It is best to power your Parent unit with the supplied AC adapter while 
using it with your home computer.

2. Open Skype and sign in to your account by entering your Skype name and 		
      password.

3. Select “Options” from the “Tools” Menu. 

4. From the list of Options, choose “Audio Settings.” 

5. 	In the Microphone Dialog Box, highlight “Wireless Audio Device.” This 
designates the Child Unit of your Home and Away Baby Video Monitor as your 
new microphone, so that you can hear your baby.

6. 	Set microphone Volume using the Volume Selector Bar or click on the 
“Automatically adjust microphone settings” check box, as you would when 
using Skype.

7. 	In the Speakers Dialog Box, highlight “Wireless Audio Device.” This designates 
the Child Unit of your Home and Away Video Monitor as your new speaker, so 
your baby will be able to hear you.

8. 	Set speaker Volume using the Volume Selector Bar or click on the 
“Automatically adjust speaker settings” check box, as you would when using 
Skype.

9. Click the “Save” button.
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Troubleshooting

Problem Possible Cause Solution

No power

(No lights on unit)

No connection

Connection indicator on 
parent unit is flashing and 
unit is beeping

Noisy feedback

(High-pitched “screech”)

  Parent Unit(s)

•   Unit is not turned on. 

•   Batteries are dead. 

  Child Unit
•   Unit is not turned on.

•   Adapter not plugged in.

•   Adapter is plugged into 
outlet that is turned off.

•   Parent Unit is too far 
from Child Unit (out of 
range).

•   Child Unit is turned off. 
 
 
 

•   Parent Unit has 
temporarily lost 
connection to Child Unit. 
 

•   Units are no longer 
digitally paired.

•   Units too close together.

•   Press and hold power 
button.

•   Recharge batteries or 
plug in adapter.

•   Move Parent Unit closer to 
Child Unit. 

•   Turn on the Child Unit. 
Connection indicator on 
both units should stop 
blinking and glow blue. 

•  	Reset system by turning 
off both units and turning 
them back on again (Child 
Unit first). 

 • 	Follow add camera 
instructions on page 9 
and add as camera 1

• 	 Be sure Parent Unit 
is at least 3 feet 
from Child Unit.

•   Press and hold power button.

•   Plug in adapter.

•   If outlet is controlled by  
a wall switch, be sure  
switch is turned on.

•   Skype has updated their 
software.

Troubleshooting

Problem Possible Cause Solution

No display image or sound, 
or very weak reception

Nightlight on Child Unit 
does not turn on or off

Nightlight on Child Unit 
does not stay on

Skype instructions are 
different than actual Skype

•   Unit is getting little or no 
power.

•   Unit is not turned on. 

•   No power to Unit. 
 
 
 
 
 
 
 

•   Setting on Parent Unit 
was not saved.

•   Unit is running on 
battery power.

Parent Unit

•   Recharge batteries or 
plug in adapter.

Child Unit

•   Make sure adapter is 
plugged in and outlet is 
receiving power.

•   Press power button. 

•   Make sure adapter is 
plugged in and outlet is 
receiving power. If outlet 
is controlled by a wall 
switch, be sure switch 
is turned on. If running 
on battery power, the 
batteries are dead. 
Replace the batteries.

•   Follow steps on page 18 
to turn nightlight on and 
off remotely.

•   While under battery 
power the nightlight will 
shut off after 60 seconds.

•   Refer to Skype.com for 
setup instructions.
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Note: This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following 
measures:

•   Reorient or relocate the receiving antenna.

•   Increase the separation between the equipment and receiver.

•   Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected.

•   Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that 
may cause undesired operation.

These devices comply with FCC and Industry Canada RF radiation exposure limits 
set forth for the general population. They must not be operated when co-located 
with any other antenna or transmitter.

Caution: To maintain the compliance with the FCC’s and Industry Canada’s RF 
exposure guideline, place the child unit at least 20 cm (8 inches) from nearby 
persons.

This Class B digital apparatus complies with Canadian ICES-003.

This device complies with RSS-310 of Industry Canada. Operation is subject to the 
condition  that this device does not cause harmful interference.

Warranty

Our Limited Warranty and Warranty Period 
When we use the terms “we,” “us,” and “our,” we are referring to Learning Curve Brands, Inc., 
and when we use the terms “you and “your,” we mean the original end-user customer. Our 
products are guaranteed to be free from defects in material and workmanship under normal 
and intended use for a period of 90 days from the date of your purchase.

Repair/Replacement 
If your product fails to meet our limited warranty during the warranty period, we will, at our 
option, repair or replace the product free of charge.

What Our Limited Warranty Does Not Cover 

We offer this limited warranty only when the product is used by the original end-user 
customer. We offer no other warranty. Additionally, while our warranty is excellent, there are 
other limits to it. We offer NO WARRANTY in cases of damage in transit, inadequate care, 
abuse, abnormal use, misuse, accident, normal wear and tear, damage due to environmental 
or natural elements, failure to follow product instructions, immersion in water (except for 
products specifically indentified by us in writing as intended for water use), battery leakage 
or improper storage or maintenance of the products.

Disclaimer of Other Warranties:
 THE EXPRESS WARRANTIES IN THE PRECEDING SECTION ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER WARRANTIES. However, to the extent applicable law does not permit disclaimers 
of certain implied warranties, such warranties are limited to the warranty period identified 
above. Some states and countries do not allow limitations on how long an implied warranty 
lasts, so the above limitations may not apply to you.

Limitation on Damages: 
IN NO EVENT SHALL WE BE LIABLE FOR INDICDENTAL, COMPENSATORY, PUNITIVE, 
CONSEQUENITAL, INDIRECT, SPECIAL, OR OTHER DAMAGES. OUR AGGREGATE LIABILITY 
WITH RESPECT TO DEFECTIVE PRODUCTS IS LIMITED TO THE MONIES PAID TO US FOR 
THE DEFECTIVE GOOD. Some states and countries do not allow the exclusion or limitation 
of incidental, consequential or other damages, so the above limitations or exclusion may not 
apply to you.

State Variations:
 This warranty gives you specific legal rights, and you may also have other rights which vary 
based on state, province, or country.

Contact Us:
 If you have a warranty claim or request, or any customer care questions, please contact us at 
cs@learningcurve.com or call us at 800-704-8697.

			   © 2011 Learning Curve Brands, Inc.
			   Oak Brook, IL 60523, U.S.A.
			   All rights reserved.
			   Made in China.
			   Y7294

Skype is a registered trademark of Skype Limited.
Windows and Windows Vista are a registered trademark of  Microsoft Corporation in the United States and �other countries.
Google is a trademark of Google, Inc.

WARNING 
Changes or modifications to this unit not expressly approved by Learning 
Curve Brands, Inc. could void the user’s authority to operate the equipment.


